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โปรแกรมภายใต้โปรแกรมทางคอมพิวเตอร์ท่ีมีช่ือว่า Arduino IDE ควบคู่กับการใช้วัสดุอุปกรณ์ทางอิเล็กทรอนิกส์
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โปรแกรมตรวจวัดคุณสมบัติอากาศช้ืนท่ีควบคุมไปถึงเนื้อหาและรายละเอียดของการติดต้ังโปรแกรมทาง
คอมพิวเตอร์ Arduino IDE การเช่ือมต่ออุปกรณ์ต่าง ๆ เพื่อสร้างกล่องเครื่องมือท่ีใช้ในการตรวจวัดค่าคุณสมบัติ
ของอากาศช้ืนดังกล่าว รวมไปถึงลักษณะและวิธีการใช้งานกล่องเครื่องมือนั้น ๆ ด้วย 
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อักษรย่อและสัญลักษณ ์

สัญลักษณ์ ควำมหมำย       หน่วย 
h  เอนทัลปี       kJ/kg 
H  ความสูงระดับพื้นดินเทียบกับะดับน้ าทะเล    m 
P  ความดัน       bar 
R  ค่าคงท่ี  
RH  ความช้ืนสัมพัทธ์       % 
T  อุณหภูมิ        °C 

T  อุณหภูมิ        K 
ตัวกรีก  ควำมหมำย  

ν  ปริมาตรจ าเพาะ       m3/kg 

ω  อัตราส่วนความช้ืนของอากาศช้ืน     kgW/kgda 

ตัวห้อย  ควำมหมำย 
a  Air   
atm  Standard atmosphere 
da  Dry air 
db  Dry bulb 
dp  Dew point 
T  Temperature 
W  Water 
wb  Wet bulb 
WS  Saturated vapor  
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กำรออกแบบระบบตรวจวัดคณุสมบตัอิำกำศชื้น 

ในการค านวณระบบท่ีมีอากาศช้ืนมาเกี่ยวข้อง โดยนิยมใช้แผนภูมิไซโครเมตริกในการวิเคราะห์ ซึ่งมีข้อจ ากัด
ในการใช้งาน คือ ต้องท าการหาค่าคุณสมบัติจากแผนภาพใหม่ทุกครั้งเมื่อมีการเปล่ียนแปลงเงื่อนไข เช่น อุณหภูมิ
กระเปาะแห้ง กระเปาะเปียก เป็นต้น รวมท้ังยุ่งยากในการน าไปใช้ในวิเคราะห์ผลข้อมูลท่ีได้จากการทดสอบและ
เก็บข้อมูล ซึ่งมีจ านวนมากและข้อมูลแตกต่างกันไป ดังนั้นจึงควรท าการพัฒนาแบบจ าลองทางคณิตศาสตร์ของ
อากาศช้ืน เพื่อรองรับการค านวณและวิเคราะห์ข้อมูล ในบทนี้จึงได้น าเสนอการพัฒนาแบบจ าลองทางคณิตศาสตร์
คุณสมบัติอากาศช้ืนโดยใช้โปรแกรม Arduino IDE ซึ่งจะมีรายละเอียดดังต่อไปนี้ 

 อำกำศชื้น 1.

อากาศช้ืน (Moist air) หรือบางครั้งเรียกว่า “อากาศเปียก” คือ อากาศท่ีมีไอน้ ารวมอยู่ด้วย โดยอากาศเปียก
ท่ีพบอยู่โดยท่ัวไปนั้นสามารถยกตัวอย่างไปถึงสภาพอากาศก่อนฝนตกท่ีพบว่ามักจะท าให้รู้สึกอบอ้าวและอึดอัด 
เพราะว่าน้ าหรือเหงื่อท่ีผิวหนังไม่สามารถระเหยออกไปได้ตามปกติ เนื่องมาจากการมีปริมาณไอน้ าในอากาศมาก
เกินไป ซึ่งโมเลกุลของน้ าท่ีปะปนอยู่ในอากาศแห้งสามารถส่งผลต่อความดันอากาศได้เหมือนกับโมเลกุลของสาร
อื่น ๆ ดังนั้นในความเป็นจริงแล้วอากาศจึงไม่ใช่ก๊าซอุดมคติ ท้ังนี้จึงมีความจ าเป็นอย่างยิ่งท่ีจะต้องใช้วิธีการ
ค านวณหาค่าความสัมพันธ์ระหว่างอุณหภูมิ ความดัน และปริมาตร ภายใต้สภาวะอื่น ๆ ท่ีไม่ใช่เงื่อนไขของก๊าซ
อุดมคติ แต่ในกรณีการค านวณเกี่ยวกับสมบัติทางอากาศท่ีความดันไม่เกิน 3 bar สามารถสมมุติให้อากาศเป็นก๊าซ
อุดมคติได้ ท้ังนี้จะมีสมการทางคณิตศาสตร์ที่เกี่ยวข้องกับอากาศช้ืนดังนี้ 

1.1 ควำมดันบรรยำกำศ (Standard atmosphere) 

ความดันบรรยากาศ หรือความดันอากาศ มีการเปล่ียนแปลงอยู่ตลอดเวลา และท่ีระดับความสูงเหนือ
ระดับน้ าทะเลต่าง ๆ จะมีค่าไม่เท่ากัน ท้ังนี้ขึ้นอยู่กับอุณหภูมิของอากาศด้วย ซึ่งความดันบรรยากาศท่ีความสูง
ระดับน้ าทะเล อุณหภูมิ 14 ºC จะมีค่าความดันบรรยากาศ 101.325 kPa โดยเมื่อมีการเพิ่มระดับความสูงเหนือ
ระดับน้ าทะเลเพิ่มข้ึน จะพบว่าค่าความดันบรรยากาศนั้นมีค่าลดน้อยลง อีกท้ังเมื่ออุณหภูมิของอากาศมีค่าเพิ่มขึ้น 
ก็จะท าให้ค่าความดันบรรยากาศมีค่าลดลงเช่นกัน ซึ่งในท่ีนี้จะท าการค านวณหาความดันบรรยากาศท่ีแปรผันตาม
ความสูงเหนือระดับน้ าทะเล ดังแสดงในสมการท่ี 1 [1] 
 

2559.5-5
atm )]H10(2.255771[325.101P       สมการท่ี 1 

 

เมื่อ Patm คือ ความดันบรรยากาศ (kPa)  
H     คือ ความสูงเหนือระดับน้ าทะเล (m) 
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1.2 ควำมดันไอ (Vapor pressure) 

ความดันไอ ในท่ีนี้หมายถึงแรงดันย่อยท่ีเกิดจากไอน้ า ท้ังนี้ความดันไอหมายถึงความดันท่ีมีความสามารถท่ี
จะท าให้สารเปล่ียนสถานะกลายเป็นไอ มีความสัมพันธ์กับจุดเดือด กล่าวคือ ณ อุณหภูมิต่างกัน ความดันไอของ
ของสารชนิดหนึ่งจะมีค่าแตกต่างกัน นั่นคือท่ีอุณหภูมิสูงความดันไอของของสารจะมีค่าสูงกว่าท่ีอุณหภูมิต่ า 
เนื่องจากโมเลกุลมีพลังงานจลน์เพิ่มขึ้น โมเลกุลจึงมีโอกาสเป็นไอได้มากขึ้น  ซึ่งในการเขียนโปรแกรมการ
ค านวณหาค่าความดันไอสามารถหาได้จากความสัมพันธ์ระหว่างความดันไออิ่มตัวและความช้ืนสัมพัทธ์  ดังสมการ
ท่ี 2 [1] 

 

)100/RH(PP WSW          สมการท่ี 2 
 

เมื่อ PW  คือ ความดันไอ (kPa) 
PWS คือ ความดันไออิ่มตัว (kPa) 
RH  คือ ความช้ืนสัมพัทธ์ (%) 

1.3 ควำมดันไออิ่มตัว (Vapor saturation pressure) 

ความดันไออิ่มตัว ในท่ีนี้หมายถึงแรงดันของไอน้ าอิ่มตัว ซึ่งสามารถหาได้จากสมการที่ 3 [1] 
 

)]Tln(CTCTCTCC)T/C[(eP db6
3
db5

2
db4db32db1WS    สมการท่ี 3 

 

เมื่อ C1   5.8002206 x 103 

C2  1.3914993 

C3   4.8640239 x 10-2 

C4  4.1764768 x 10-5 

C5   1.4452093x 10-8 

C6  6.5459673 

1.4 อุณหภูมิกระเปำะแห้ง (Dry bulb temperature) 

อุณหภูมิกระเปาะแห้ง คือ อุณหภูมิของอากาศหรืออากาศช้ืนท่ีสามารถอ่านได้จากเทอร์โมมิเตอร์โดยตรง ซึ่ง
ในขั้นตอนการวัดจะต้องวัดในขณะท่ีอากาศสามารถถ่ายเทได้อย่างสะดวก จึงจะได้ค่าอุณหภูมิท่ีถูกต้อง  
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1.5 อุณหภูมิจุดน้ ำค้ำง (Dew point temperature) 

อุณหภูมิจุดน้ าค้าง หมายถึง อุณหภูมิท่ีเมื่ออากาศช้ืนถูกท าให้เย็นลงขณะท่ีปริมาณไอน้ ายังคงท่ี การลด
อุณหภูมิถึงจุดหนึ่งจะท าให้ไอน้ าเกิดการอิ่มตัว และกล่ันตัวควบแน่นเป็นหยดน้ า (Condensate) ท่ีความดัน
บรรยากาศคงท่ี ตัวอย่างอุณหภูมิจุดน้ าค้างท่ีพบได้ในชีวิตประจ าวัน เช่น การต้ังแก้วน้ าเย็นไว้ และมีหยดน้ ามา
เกาะท่ีผิวแก้วด้านนอก เกิดข้ึนเนื่องจากอุณหภูมิของอากาศบริเวณแก้วน้ าเย็นต่ ากว่าจุดน้ าค้างและกล่ันตัวเกาะอยู่
บนผิวแก้ว ในการค านวณครั้งนี้จะท าการหาอุณหภูมิจุดน้ าค้างจากความสัมพันธ์ระหว่างความช้ืนสัมพัทธ์และ
อุณหภูมิกระเปาะแห้ง ดังแสดงในสมการท่ี 4 [1] 

 









































db

db

db

db

dp

T12.243

T62.17

100

RH
ln62.17

T12.243

T62.17

100

RH
ln12.243

T      สมการท่ี 4 

 

เมื่อ Tdp  คือ อุณหภูมิจุดน้ าค้าง (ºC) 
RH   คือ ความช้ืนสัมพัทธ์ (%) 
Tdb   คือ อุณหภูมิกระเปาะแห้ง (ºC) 

1.6 อุณหภูมิกระเปำะเปียก (Wet bulb temperature) 

อุณหภูมิกระเปาะเปียกแสดงให้เห็นถึงความสามารถในการระเหยของน้ าท่ีสภาวะอากาศหนึ่ง ๆ โดยท าการ
วัดด้วยการใช้เทอร์โมมิเตอร์ท่ีคลุมหรือหุ้มด้วยผ้าท่ีเปียกน้ า ซึ่งหากความช้ืนในอากาศมีน้อยจะท าให้น้ าสามารถ
ระเหยได้ง่าย จึงท าให้ผลต่างระหว่างอุณหภูมิกระเปาะแห้งและกระเปาะเปียกมีค่าต่างกันมาก และในทางกลับกัน 
หากความช้ืนในอากาศมีมากจะท าให้น้ าระเหยได้ยาก ท าให้ผลต่างระหว่างอุณหภูมิกระเปาะแห้งและกระเปาะ
เปียกมีค่าไม่ต่างกันมากนัก ซึ่งในการค านวณครั้งนี้จะใช้สมการท่ี 5 [1] ในการค านวณ 

 

)ba(/)bTaT(T dbdbwb        สมการท่ี 5 
 

เมื่อ Twb คือ อุณหภูมิกระเปาะเปียก (ºC) 
Tdb คือ อุณหภูมิกระเปาะแห้ง (ºC) 
a และ b คือ ค่าท่ีได้จากการค านวณค่าจากความดันบรรยากาศ ซึ่ง a = 0.000066Patm และจากการ

ค านวณค่าจากความดันไอและอุณหภูมิจุดน้ าค้าง ซึ่ง 2
dpW )15.273T/(P8.409b   
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1.7 อัตรำส่วนควำมชื้น (Humidity ratio) 

อัตราส่วนความช้ืน บางครั้งเรียกว่า ความช้ืนจ าเพาะ หมายถึงมวลของไอน้ าต่อมวลของอากาศแห้ง แต่ท้ังนี้
อัตราส่วนความช้ืน สามารถค านวณได้จากความสัมพันธ์ของสมการของก๊าซสมบูรณ์และกฎของดาลตัน ดังสมการ
ท่ี 6 [1] 

 

)]PP(/P[621945.0 WatmW         สมการท่ี 6 
 

เมื่อ ω   คือ อัตราส่วนความช้ืน (kgW/kgda) 
PW   คือ ความดันไอ (kPa) 
Patm คือ ความดันบรรยากาศ (kPa) 

1.8 ปริมำตรจ ำเพำะของอำกำศชื้น (Specific volume of moist air) 

ปริมาตรจ าเพาะของอากาศช้ืน คือ อัตราส่วนของปริมาตรของไอน้ าต่อมวลของอากาศแห้ง ซึ่งสามารถ
ค านวณหาได้จากสมการท่ี 7 [1] 

 

atmdbdaa P/)]607858.1(1[TR        สมการท่ี 7 
 

เมื่อ ν   คือ ปริมาตรจ าเพาะของอากาศช้ืน (m3/kgda) 
'
dbT  คือ อุณหภูมิกระเปาะแห้ง (K) 
ω   คือ อัตราส่วนความช้ืน (kgW/kgda) 
 Rda คือ ค่าคงท่ีท่ีมีค่าเท่ากับ 0.287042  kJ/kgda·K  

1.9 เอนทัลปีของอำกำศชื้น (Enthalpy) 

เอนทัลปีของอากาศช้ืน หรือพลังงานความร้อนรวม เป็นค่าท่ีแสดงถึงปริมาณพลังงานความร้อนท่ีสะสมอยู่ใน
อากาศ อันเป็นผลรวมของเอนทัลปีของอากาศแห้งและไอน้ าท่ีอยู่ในอากาศ ท้ังนี้ค่าเอนทัลปีของอากาศช้ืนสามารถ
ค านวณหาได้จากสมการท่ี 8 [1] 

 

)T8057.11.501,2(T006.1h dbdba       สมการท่ี 8 
 

เมื่อ ha   คือ เอนทัลปีของอากาศช้ืน (kJ/kgda) 
Tdb คือ อุณหภูมิกระเปาะแห้ง (ºC) 
ω  คือ อัตราส่วนความช้ืน (kgW/kgda) 
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 แบบจ ำลองทำงคณิตศำสตร์ของคุณสมบัติอำกำศช้ืน 2.

ในการค านวณระบบท่ีมีอากาศช้ืนมาเกี่ยวข้อง โดยนิยมใช้แผนภูมิไซโครเมตริกในการวิเคราะห์ ซึ่งมีข้อจ ากัด
ในการใช้งาน คือ ต้องท าการหาค่าคุณสมบัติจากแผนภาพใหม่ทุกครั้งเมื่อมีการเปล่ียนแปลงเงื่อนไข เช่น อุณหภูมิ
กระเปาะแห้ง กระเปาะเปียก เป็นต้น รวมท้ังยุ่งยากในการน าไปใช้ในวิเคราะห์ผลข้อมูลท่ีได้จากการทดสอบและ
เก็บข้อมูล ซึ่งมีจ านวนมากและข้อมูลแตกต่างกันไป ดังนั้นจึงควรท าการพัฒนาแบบจ าลองทางคณิตศาสตร์ของ
อากาศช้ืน เพื่อรองรับการค านวณและวิเคราะห์ข้อมูล 

ในบทนี้น าเสนอการพัฒนาแบบจ าลองทางคณิตศาสตร์คุณสมบัติอากาศช้ืน โดยใช้โปรแกรม Arduino IDE 
และมีเงื่อนไขเริ่มต้นการค านวณ คือ อุณหภูมิกระเปาะแห้ง (Tdb) ความช้ืนสัมพัทธ์ (RH) และความสูงของพื้นท่ี
เหนือระดับน้ าทะเล (H) ดังแสดงสมการท่ีใช้ในการพัฒนาแบบจ าลองและรายละเอียดโปรแกรมคอมพิวเตอร์ 
Arduino IDE ดังแสดงในตารางท่ี 1 และขั้นตอนการค านวณในรูปท่ี 1 

 

ตารางท่ี 1 การคุณสมบัติอากาศช้ืนจากความดันบรรยากาศ อุณหภูมิกระเปาะแห้งและเปียก 

คุณสมบัติอำกำศชื้น สมกำรและค ำสั่งที่ใช้ในแบบจ ำลอง 

ความดันบรรยากาศ (Patm) 101.325(1 – 2.25577 x 10-5 H)5.2559 

อุณหภูมิจุดน้ าค้าง (Tdb) 









































db

db

db

db

db

T12.243

T62.17

100

RH
ln62.17

T12.243

T62.17

100

RH
ln12.243

T  

อุณหภูมิกระเปาะเปียก (Twb) 
Twb  (aTdb  bTdp) / (a  b) 

a  0.000066Patm 

b  409.8PW / (Tdp + 273.15)2 

อัตราส่วนความช้ืน (ω) 0.621945[PW / (Patm – PW)] 

ปริมาตรจ าเพาะ (a) RdaTdb[1 + (1.607858ω)] / Patm 

เอนทัลปี (ha) 1.006Tdb + ω(2,501.1 + 1.8057Tdb) 
 

 โปรแกรมตรวจวัดคุณสมบัติอำกำศชื้น 3.

การพัฒนารหัสโปรแกรมคอมพิวเตอร์ Arduino IDE ในการสร้างโปรแกรมคุณสมบัติอากาศช้ืน ท่ีมีการรับค่า
อุณหภูมิกระเปาะแห้ง (Tdb) และความช้ืนสัมพัทธ์ของอากาศ (RH) และค่าความสูงเหนือระดับน้ าทะเล (H) ซึ่งจะ
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แสดงผลบนจอ LCD โดยผ่านการประมวลผลจากบอร์ดไมโครคอนโทรลเลอร์ตระกูล Arduino จะมีรายละเอียดใน
การค านวณเพื่อหาค่าความดันบรรยากาศ (Patm) อุณหภูมิจุดน้ าค้าง (Tdb) อุณหภูมิกระเปาะเปียก (Twb) 

อัตราส่วนความช้ืน (ω) ปริมาตรจ าเพาะ (a) และเอนทัลปี (ha) ของอากาศช้ืนดังแสดงในแผนผังรูปท่ี 1 
 

 

รูปท่ี 1 ขั้นตอนการค านวณของแบบจ าลองทางคณิตศาสตร์ของโปรแกรมอากาศช้ืน 



7 
 

 ในการพัฒนาโปรแกรมและอุปกรณ์วัดคุณสมบัติอากาศช้ืนในครั้งนี้ จะใช้อุปกรณ์เซ็นเซอร์ท่ีใช้ในการรับ
ค่าข้อมูลขาเข้าและแสดงผลของข้อมูลท่ีต้องการดังท่ีได้กล่าวไปแล้วข้างต้น ซึ่งจะมีรายละเอียดของอุปกรณ์ ดัง
แสดงในตารางท่ี 2 
 

ตารางท่ี 2 วัสดุอุปกรณ์ท่ีใช้ในการพัฒนาโปรแกรมและอุปกรณ์วัดคุณสมบัติอากาศช้ืน 
อุปกรณ์ หน้ำที่ คุณสมบัติ 

1. บอร์ดไมโครคอนโทรลเลอร์ 
Arduino Mega R3 

 

ประมวลผลข้อมูลท่ีรับได้จาก
เซ็นเซอร ์

- แรงดันไฟฟ้าภายใน 5 V 
- แรงดันไฟฟ้าเข้า 7-12 V 
- Digital Pin 54 ขา 
- Analog Pin 16 ขา 
- สัญญาณนาฬิกา 16 MHz 

2. จอแอลซีดี (LCD) ขนาด 20 x 4 

 

 

ท าหน้าท่ีแสดงผลของข้อมูล
ตามค าส่ังจากบอร์ด
ไมโครคอนโทรลเลอร์ 

- แรงดันไฟฟ้าเข้า 5 V 
- จ า น ว น ตั วอั ก ษ ร  2 0  ตั ว  4 
บรรทัด 
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อุปกรณ์ หน้ำที่ คุณสมบัติ 

3. LCD adapter I2C 

 

ท าหน้าท่ีช่วยเสริมการใช้งาน
ของโมดูล LCD ในด้านการลด
จ านวนขาต่อสัญญากับบอร์ด

ไมโครคอนโทรลเลอร์ 

- แรงดันไฟฟ้าเข้า 5 V 

4. DHT22 (AM2302) 

 

เป็นเซ็นเซอร์ท่ีใช้วัดค่าอุณหภูมิ
กระเปาะแห้งและค่าความช้ืน

สัมพัทธ์ 

- แรงดันไฟฟ้าเข้า 3.3-6 V 
- ช่วงค่าความช้ืนสัมพัทธ์ท่ีวัดได้ 0 
ถึง 100%  (±2%) 
- ช่วงค่าอุณหภูมิกระเปาะแห้งท่ีวัด
ได้ -40 ถึง 80  °C (±0.5 °C) 

 
ในส่วนของการพัฒนารหัสโปรแกรมและอุปกรณ์เพื่อการวัดค่าคุณสมบัติอากาศช้ืนในครั้งนี้ จะเลือกใช้

โปรแกรม Arduino ซึ่ง Arduino เป็นโปรแกรมทางคอมพิวเตอร์และฮาร์ดแวร์ท่ีมีลักษณะเป็น Open source 
กล่าวคือสามารถดาวน์โหลดตัวโปรแกรมไปพัฒนาต่อยอดได้โดยไม่ต้องเสียค่าใช้จ่าย ซึ่งในปัจจุบันเป็นเทคโนโลยีท่ี
ได้รับความนิยมเป็นอย่างมากในการประยุกต์ใช้รับส่งค่าสัญญาณจากเซ็นเซอร์อิเล็กทรอนิกส์ โดยในส่วนของด้าน
การวัดทางพลังงานทดแทนต่าง ๆ ล้วนมีความจ าเป็นท่ีจะต้องมีการใช้เซ็นเซอร์อิ เล็กทรอนิกส์  ซึ่งส่วนมากจะ
ค่อนข้างมีราคาสูงเมื่อท าการซื้ออุปกรณ์หรือโปรแกรมส าเร็จรูปมาใช้ ดังนั้นเพื่อเป็นการลดราคาค่าใช้จ่ายดังกล่าว 
เทคโนโลยี Arduino จึงเข้ามามีบทบาทส าคัญในการพัฒนาการสร้างโปรแกรมและอุปกรณ์ในการวัดค่าหรือ
ประมวลผลทางข้อมูลต่าง ๆ มากยิ่งขึ้น ดังนั้นในการพัฒนาโปรแกรมและอุปกรณ์ท่ีใช้ในการวั ดคุณสมบัติของ
อากาศช้ืนครั้งนี้ จึงได้ท าการน า Arduino มาบูรณาการใช้ท้ังทางด้านโปรแกรมทางคอมพิวเตอร์และฮาร์ดแวร์ ซึ่ง
จะมีข้ันตอนการติดต้ัง การเริ่มต้นใช้งาน การทดลองใช้งานกับอุปกรณ์ต่าง ๆ ตลอดจนการพัฒนารหัสโปรแกรม
เพื่อใช้กับการวัดคุณสมบัติของอากาศช้ืน ดังรายละเอียดในหัวข้อต่อไปนี้ 
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3.1 กำรติดต้ังโปรแกรม Arduino 

ในการติดต้ังโปรแกรม Arduino จะมีข้ันตอนและรายละเอียดดังต่อไปนี้ 
1) เข้าไปยังหน้าเว็บเพจของ Arduino “https://www.arduino.cc/en/Main/Software” แล้วท าการ

ดาวน์โหลดโดยการคลิกเมาส์ไปยัง “Windows Installer” ดังรูปท่ี 2 
 

 
 

รูปท่ี 2 หน้าเว็บเพจในส่วนของการดาวน์โหลดโปรแกรม 
 

2) คลิกท่ีไอคอน “JUST DOWNLOAD” ดังรูปท่ี 3 ซึ่งหากต้องการดาวน์โหลดในแบบท่ีมีการบริจาคเงิน
ให้แก่องค์กร ให้คลิก “CONTRIBUTE & DOWNLOAD” 
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รูปท่ี 3 หน้าเว็บเพจส่วนของการดาวน์โหลด 
 

3) เมื่อดาวน์โหลดเสร็จแล้ว จะได้ไฟล์ท่ีท าการดาวน์โหลดท่ีมี ช่ือว่า “arduino-1.8.5-windows.exe” 
จากนั้นให้ท าการเปิดไฟล์และคลิกท่ีไอคอน “I Agree” เพื่อท าการเริ่มติดต้ังโปรแกรม Arduino IDE  ซึ่งในส่วนท่ี
น ามาแสดงตัวอย่างการติดต้ัง จะเป็นโปรแกรม Arduino IDE เวอร์ชัน 1.8.5 ดังรูปท่ี 4 

 

 
 

รูปท่ี 4 หน้าต่างส่วนของการเริ่มติดต้ัง 
 

4) คลิกท่ีไอคอน “Next >“ เพื่อตอบตกลงในส่วนของขั้นตอนถัดไป ดังรูปท่ี 5 
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รูปท่ี 5 หน้าต่างของส่วนตัวเลือกติดต้ังโปรแกรม 
 

5) เลือกโฟลเดอร์ท่ีต้องการท าการติดต้ังโปรแกรม Arduino IDE เมื่อท าการเลือกโฟลเดอร์เสร็จเรียบร้อย
แล้ว ให้คลิกท่ีไอคอน “Install” ดังรูปท่ี 6 

 
 

รูปท่ี 6 หน้าต่างการเลือกโฟลเดอร์ในการติดต้ัง 
 

6) รอให้โปรแกรมท าการติดต้ังจนแล้วเสร็จ (สามารถตรวจสอบความก้าวหน้าในการติดต้ังได้โดยการคลิกท่ี
ไอคอน Show details) ดังรูปท่ี 7 
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รูปท่ี 7 โปรแกรมท าการติดต้ัง 
 

7) เมื่อโปรแกรมติดต้ังเสร็จแล้ว บรรทัดสุดท้ายจะแสดงค าว่า “Completed” จากนั้นให้คลิกไอคอน 
“Close” เพื่อท าการปิดโปรแกรม ซึ่งเป็นอันส้ินสุดขั้นตอนของการติดต้ัง ดังรูปท่ี 8 

 

 
 

รูปท่ี 8 ข้อความท่ีแสดงเมื่อท าการติดต้ังโปรแกรมเสร็จ 

3.2 เร่ิมต้นกำรใช้งำนเพื่อกำรพัฒนำรหัสโปรแกรมคุณสมบัติอำกำศชื้น 

ในการเริ่มต้นใช้งานโปรแกรม Arduino IDE เพื่อการพัฒนารหัสโปรแกรมคุณสมบัติอากาศช้ืน จะมีขั้นตอน
และรายละเอียดดังต่อไปนี้ 

1) เปิดโปรแกรม Arduino IDE โดยการดับเบิลคลิกท่ีไอคอนโปรแกรม Arduino ดังรูปท่ี 9 
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รูปท่ี 9 เริ่มต้นการใช้งานโปรแกรม Arduino 
 

2) ให้สังเกตหน้าต่างของส่วนโปรแกรม Arduino IDE ดังรูปท่ี 10 จะสังเกตเห็นค าส่ังภายใน (ในท่ีนี้ใช้ภาษา 
C ในการเขียนโปรแกรมและค าส่ัง) ซึ่งได้แบ่งดังนี้ 

ส่วนท่ี 1 ส่วนของค าส่ังการตั้งค่า (void setup) เป็นส่วนท่ีเขียนค าส่ังลงไปโดยการเขียนค าส่ังท่ีท างานเพียง
ครั้งเดียว และค าส่ังจะต้องอยู่ภายในสัญลักษณ์ “{ }” เท่านั้น 

ส่วนท่ี 2 ส่วนของค าส่ังท่ีวนจนกว่าจะท าการปิดระบบ (void loop) และค าส่ังจะต้องอยู่ภายในสัญลักษณ์ “{ 
}” เท่านั้น 
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รูปท่ี 10 หน้าต่างของโปรแกรม Arduino IDE 
 

3) ท าการติดต้ังไลบรารี (Library) ท่ีต้องการใช้งาน (ไลบรารี คือ หน่วยค าส่ังย่อยท่ีผู้ใช้สามารถท าการดึง
ค าส่ังพิเศษจากไลบรารีนั้น ๆ ได้) ในท่ีนี้ได้ใช้ไลบรารีของเซนเซอร์วัดอุณหภูมิความช้ืนสัมพัทธ์ และโมดูล LCD I2C 
ท่ีใช้ในการท าการทดลอง โดยการติดต้ังจะเข้าไปยังหน้าต่างด้วยการคลิกท่ี “Sketch” > “Include Library” > 
“Manage Libraries” ดังรูปท่ี 11 

 

 
 

รูปท่ี 11 เริ่มต้นการติดต้ังไลบรารี 
 

4) ใส่ค าส าคัญลงในช่องท่ีต้องการค้นหาเพื่อค้นหาไลบรารี (ในขั้นตอนนี้ได้ท าการติดต้ังไลบรารี DHT22 ซึ่ง
เป็นเซนเซอร์ท่ีใช้ในการทดลอง) เมื่อค้นหาเจอแล้วให้คลิกท่ีไอคอน “Install” ดังรูปท่ี 12 

 

 

 

1 

2 
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รูปท่ี 12 หน้าต่างของส่วนท่ีท าการติดต้ังไลบรารี DHT22 
 

5) ท าการติดต้ังไลบรารีของ LiquidCrytal I2C ซึ่งจะติดต้ังโดยการคลิกท่ี “Install” รูปท่ี 13 
 

 
 

รูปท่ี 13 หน้าต่างของส่วนท่ีท าการติดต้ังไลบรารี LiquidCrytal I2C 

3.3 กำรทดลองกำรใช้งำนอุปกรณ์ร่วมกับไลบรำรี 

ส าหรับการทดลองการใช้งานอุปกรณ์ร่วมกับไลบรารีท่ีท าการติดต้ังไปแล้วข้างต้น จะมีรายละเอียดดังขั้นตอน
ต่อไปนี้ 

1) ท าการทดลองการใช้งานของโมดูลจอแสดงผล LCD โดยการคลิกท่ี “File” > “Examples” > 
“LiquidCrystal I2C” > “HelloWorld” ดังรูปท่ี 14 
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รูปท่ี 14 เลือกโปรแกรมตัวอย่างของ LCD I2C 
 

2) เมื่อท าการเปิดโปรแกรมทดลองของ LCD I2C เสร็จแล้วหลังจากนั้นให้สังเกตท่ีส่วนของค าส่ังภายใน จะ
พบว่ามีส่วนท่ีเขียนท้ังหมด 4 ส่วน ดังแสดงในรูปท่ี 15 คือ 

ส่วนท่ี 1 เป็นส่วนท่ีใช้ในการดึงชุดข้อมูลไลบรารีโดยจะมีค าส่ัง “#include” อยู่ข้างหน้าช่ือไฟล์ไลบรารีท่ีอยู่
ใน “<>” เสมอ 

ส่วนท่ี 2 เป็นส่วนท่ีเป็นชุดค าส่ังท่ีท างานครั้งเดียวต่อการเปิดระบบหนึ่งครั้งและท่ีส าคัญ จะเป็นค าส่ัง “void 
setup()” และค าส่ังในการท างานจะอยู่ภายใต้เครื่องหมาย “{ }” เสมอ 

ส่วนท่ี 3 เป็นส่วนท่ีเป็นชุดค าส่ังท่ีท างานวนซ้ าตลอดเมื่อเปิดระบบจะเป็นค าส่ัง “void loop()” และค าส่ังใน
การท างานจะอยู่ภายใต้เครื่องหมาย “{ }” เสมอ 

ส่วนท่ี 4 เป็นส่วนท่ีท าหน้าท่ีเป็นข้อความซึ่งไม่มีผลต่อค าส่ังภายในโปรแกรมโดยจะมีเครื่องหมาย “//” อยู่
หน้าข้อความเสมอ 
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รูปท่ี 15 ชุดค าส่ังโปรแกรมทดลองของ LCD I2C 
 

3) ท าการเลือกรุ่นของบอร์ดให้ตรงกันท่ีใช้ในการทดลอง (ในท่ีนี้ได้ใช้บอร์ด Arduino Mega R3 ในการ
ทดลอง) ดังรูปท่ี 16 

 

 
 

รูปท่ี 16 การเลือกรุ่นบอร์ดในการทดลอง 
 

1 

2 

3 

4 
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4) เลือกพอร์ทท่ีเช่ือมต่อคอมพิวเตอร์ไปยังบอร์ด (ในท่ีนี้ได้ใช้พอร์ทช่ือ COM3) ดังรูปท่ี 17 

 

 
 

รูปท่ี 17 การเลือกพอร์ทท่ีเช่ือมต่อกับบอร์ด 
 

5) ท าการอัพโหลดโปรแกรมไปยังบอร์ดโดยการคลิกท่ีเครื่องหมายอัพโหลดของโปรแกรม Arduino IDE ดัง
รูปท่ี 18 

 

 
 

รูปท่ี 18 การอัพโหลดโปรแกรมไปยังบอร์ดชุดทดลอง 
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6) สังเกตบอร์ดทดลองท่ีโมดูลจอ LCD แล้วสังเกตข้อความดังรูปท่ี 19 
 

 
 

รูปท่ี 19 ข้องความท่ีแสดงยังโมดูล LCD 
 

7) ท าการทดลองเซนเซอร์ DHT22 โดยคลิกท่ี File > Examples > DHT sensor library > DHTtester 
แล้วท าการอัพโหลดโปรแกรมเข้าไปยังบอร์ดทดลอง และสังเกตค่าผ่านพอร์ทอนุกรม (Serial Mornitor) ดังรูปท่ี 
20 
 

 
 

รูปท่ี 20 โปรแกรมทดลองของเซนเซอร์ DHT22 
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8) สังเกตค่าผ่านพอร์ทอนุกรม หากในกรณีท่ีต่อเซนเซอร์ไม่ถูกต้องจะปรากฏข้อความ “Failed to read 

from DHT sensor!” และกรณีท่ีท่ีเซนเซอร์ต่อเข้ากับบอร์ดทดลองถูกต้องจะแสดงผล ดังรูปท่ี 21 
 

 
 

รูปท่ี 21 หน้าต่างแสดงผลของเซนเซอร์ DHT22 

3.4 กำรพัฒนำรหัสโปรแกรม Arduino เพือ่กำรตรวจวัดค่ำคุณสมบัติอำกำศชื้น 

การพัฒนารหัสโปรแกรม Arduino เพื่อการตรวจวัดค่าคุณสมบัติอากาศช้ืน 
1) ท าการเขียนค าส่ังลงในโปรแกรม Arduino IDE เพื่อหาคุณสมบัติของอากาศจากการวัดค่าอุณหภูมิและ

ความช้ืนสัมพัทธ์ของอากาศ โดยมีการเขียนค าส่ังและรายละเอียดดังนี้ 
 

#include <Wire.h>     //เรียกใช้ไลบรารีของ Wire 
#include <LiquidCrystal_I2C.h>   //เรียกใช้ไลบรารีของ LCD I2C 
#include "DHT.h"     //เรียกใช้ไลบรารีของ DHT 
#define DHTPIN 2     //ต้ังช่ือ DHTPIN แทน 2 
#define DHTTYPE DHT22    //ต้ังช่ือ DHTTYPE แทน DHT22 
#define High 310     //ต้ังช่ือ High แทน 310  *ความสูงจากน้ าทะเล 
#define R 0.287042     //ต้ังช่ือ R แทน 0.287042 
#define C1 -5.8002206*pow(10,-3)   //ต้ังช่ือ C1-C6 เป็นจ านวนใด ๆ ท่ีใช้ในสมการ 
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#define C2 1.3914993    
#define C3 -4.8640239*pow(10,-2) 
#define C4 4.1764768*pow(10,-5) 
#define C5 -1.4452093*pow(10,-8) 
#define C6 6.5459673 
#define e 2.71828     //ต้ังช่ือ e แทน 2.71828  *ค่าคงท่ี 
#define tim 5000     //ต้ังช่ือ tim แทน 5000  *ใช้ในการหน่วงเวลา 
LiquidCrystal_I2C lcd(0x27, 20, 4);   //ต้ังค่า LCD I2C เป็นขนาด 20 x 4 ช่ือ lcd 
DHT dht(DHTPIN, DHTTYPE); //ต้ังค่าเซนเซอร์ DHT ต่อสัญญาณท่ีขา DHTPIN     
                                                                           และเป็นชนิด DHTTYPE ช่ือ dht 
float T, H, P_atm, P_w, P_ws, tem_dp, tem_wp, hum_r, v, h; //สร้างตัวแปรชนิด float 
 

void setup() { 
lcd.init();      //เริ่มการใช้งานของ LCD 
dht.begin();     //เริ่มการใช้งาน DHT22 
lcd.backlight();     //ส่ังใหไฟพื้นหลังสว่าง 

} 
 

void loop() { 
check();      //ไปยังฟังก์ชัน check 
peasur();      //ไปยังฟังก์ชัน peasur 
temp_dp();     //ไปยังฟังก์ชัน temp_dp 
temp_wb();     //ไปยังฟังก์ชัน temp_wb 
hum_ratio();     //ไปยังฟังก์ชัน hum_ratio 
viloc();      //ไปยังฟังก์ชัน viloc 
Enthalpy();     //ไปยังฟังก์ชัน Enthalpy 
show();      //ไปยังฟังก์ชัน show 

} 
 

void check() {      //ฟังก์ชัน check ส่วนของการรับค่าจากเซนเซอร์ 
T = dht.readTemperature();   //ค าส่ังให้รับค่าอุณหภูมิเขามาเก็บท่ีตัวแปร T 
H = dht.readHumidity();    //ค าส่ังให้รับค่าความช้ืนสัมพัทธ์เขามาเก็บท่ีตัวแปร                                  
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                                                                     H 
 

 if (isnan(h) || isnan(t) || isnan(f)) {   //เงื่อนไขถ้าไม่มีการเช่ือมต่อกับเซนเซอร์ 
Serial.println("Failed to read from DHT sensor!"); //แสดงข้อความไปยัง Serial monitor 
return; 

 } 
 

 delay(500);     //หน่วงเวลา 0.5 วินาที 
} 
 

void peasur() {      //ฟังก์ชันค าส่ังของการค านวณหาค่าความดัน 
                                                                           บรรยากาศ 

P_atm = 101.325 * pow((1 - ((2.25577 * 0.00001) * High)), 5.2559); 
P_ws = e * ((C1 / T) + C2 + (C3 * T) + (C4 * pow(T, 2)) + (C5 * pow(T, 3)) + (C6 * log(T))); 
P_w = P_ws * (H / 100); 

} 
 

void temp_dp() {     //ฟังก์ชันค าส่ังของการค านวณหาค่าอุณหภูมิจุด 
                                                                          น้ าค้าง 

float B = log(H / 100); 
tem_dp = 243.12 * (B + ((17.62 * T) / (243.12 + T))) / (17.62 - B - ((17.62 * T) / (243.12 + T))); 

} 
 

void temp_wb() {     //ฟังก์ชันค าส่ังของการค านวณหาค่าอุณหภูมิ 
                                                                           กระเปาะเปียก 

float a = 0.000066 * P_atm; 
float b = (409.8 * P_w) / pow((T + 273.15), 2); 
tem_wp = ((a * T) + (b * tem_dp)) / (a + b); 

} 
 

void hum_ratio() {     //ฟังก์ชันค าส่ังของการค านวณหาค่าอัตราส่วน 
                                                                          ความช้ืนในอากาศ 

hum_r = 0.621945 * (P_w / (P_atm - P_w)); 
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} 
 

void viloc() {      //ฟังก์ชันค าส่ังของการค านวณหาค่าปริมาตร 
                                                                           จ าเพาะ 

v = R *  (T + 273.15) * ((1 + (1.607858 * hum_r )) / P_atm); 
} 
 

void Enthalpy() {     //ฟังก์ชันค าส่ังของการค านวณหาค่าเอนทัลปีของ 
                                                                           อากาศ 

h = (1.006 * T) + (hum_r * (2501.1 + (1.8057 * T))); 
} 
 

void show() {      //ฟังก์ชันค าส่ังของการแสดงผลไปยังโมดูล LCD 
lcd.clear();      //ค าส่ังล้างหน้าจอท่ี 1 
lcd.setCursor(0, 0);    //ค าส่ังต้ังค่าตัวอักษรท่ีจะท าการแสดงในตัวอักษรท่ี 
                                                                     0 แถว 0 
lcd.print("Relative Humidity");   //แสดงข้อความ “Relative Humidity” โมดูล LCD 
lcd.setCursor(0, 1);    //ค าส่ังต้ังค่าตัวอักษรท่ีจะท าการแสดงในตัวอักษรท่ี 
                                                                     0 แถว 1 
lcd.print(H);     //แสดงค่าความช้ืนสัมพัทธ์ที่เก็บไว้ในตัวแปรท่ีช่ือว่า 
                                                                     H 
lcd.print(" %");     //แสดงสัญลักษณ์หน่วยของข้อความก่อนหน้า 
lcd.setCursor(0, 2);    //ค าส่ังต้ังค่าตัวอักษรท่ีจะท าการแสดงในตัวอักษรท่ี 

         0 แถว 2 
lcd.print("Dry-bulb Temp");   //แสดงข้อความ “Dry-bulb Temp” โมดูล LCD 
lcd.setCursor(0, 3);    //ค าส่ังต้ังค่าตัวอักษรท่ีจะท าการแสดงในตัวอักษรท่ี 
               0 แถว 3 
lcd.print(T);     //แสดงค่าอุณหภูมิกระเปาะแห้งท่ีเก็บไว้ในตัวแปรท่ี 
                                                                     ช่ือว่า T 
lcd.print(" C"); 
delay(tim);     //หน่วงเวลาท่ีมีค่าเท่ากับ tim หน่วยเป็น ms 
lcd.clear();      //ค าส่ังล้างหน้าจอเพื่อเตรียมแสดงข้อมูลในหน้าจอ 
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                                                                     ท่ี 2 
lcd.setCursor(0, 0);   
lcd.print("Barometric Pressure"); 
lcd.setCursor(0, 1); 
lcd.print(P_atm); 
lcd.print(" kPa"); 
lcd.setCursor(0, 2); 
lcd.print("Dew point Temp"); 
lcd.setCursor(0, 3); 
lcd.print(tem_dp); 
lcd.print(" C"); 
delay(tim); 
lcd.clear();      //ค าส่ังล้างหน้าจอเพื่อเตรียมแสดงข้อมูลในหน้าจอ 
                                                                     ท่ี 3 
lcd.setCursor(0, 0); 
lcd.print("Wet-bulb Temp"); 
lcd.setCursor(0, 1); 
lcd.print(tem_wp); 
lcd.print(" C"); 
lcd.setCursor(0, 2); 
lcd.print("Humidity Ratio"); 
lcd.setCursor(0, 3); 
lcd.print(hum_r); 
lcd.print(""); 
delay(tim); 
lcd.clear();      //ค าส่ังล้างหน้าจอเพื่อเตรียมแสดงข้อมูลในหน้าจอ 
                                                                     ท่ี 4 
lcd.setCursor(0, 0); 
lcd.print("Specific Volume"); 
lcd.setCursor(0, 2); 



25 
 
lcd.print("Ethalpy"); 
lcd.setCursor(0, 1); 
lcd.print(v); 
lcd.print(" m3/kg"); 
lcd.setCursor(0, 3); 
lcd.print(h); 
lcd.print(" kJ/kg"); 
delay(tim); 

} 
 

2) เมื่อท าการเขียนโปรแกรมเป็นท่ีเรียบร้อยแล้ว ให้อัพโหลดโปรแกรมเข้าไปยังบอร์ดทดลองแล้วสังเกตท่ี
หน้าจอ LCD จะแสดงผลดังรูปท่ี 22 

 

 
 

รูปท่ี 22 หน้าจอแสดงผลของโปรแกรมคุณสมบัติอากาศช้ืน 

3.5 กำรต่ออุปกรณ์วัดค่ำคุณสมบัติอำกำศชื้น 

ส าหรับการออกแบบอุปกรณ์ภายนอกหรือฮาร์ดแวร์ที่ใช้วัดคุณสมบัติอากาศช้ืนในครั้งนี้ จะมีแผนภาพการต่อ
วงจรของวัสดุอุปกรณ์ต่าง ๆ ดังท่ีได้กล่าวไปแล้วในตารางท่ี 2 ดังแสดงในรูปท่ี 23 ซึ่งหลังจากทดสอบระบบการวัด
ค่าคุณสมบัติอากาศช้ืนท่ีมีการต่ออุปกรณ์ดังกล่าวกับรหัสโปรแกรมท่ีพัฒนาภายใต้โปรแกรมทางคอมพิวเตอร์ของ 
Arduino IDE ส าเร็จแล้ว จะท าการติดต้ังอุปกรณ์ไว้ในกล่องเพื่อความเรียบร้อยและสะดวกต่อการใช้งาน ดังแสดง
ในรูปท่ี 24 ซึ่งเมื่อติดต้ังแล้วเสร็จจะได้กล่องโปรแกรมวัดคุณสมบัติอากาศช้ืน ดังแสดงในรูปท่ี 25 
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รูปท่ี 23 แผนภาพการต่อวงจรของวัสดุอุปกรณ์ต่าง ๆ ท่ีใช้วัดค่าคุณสมบัติอากาศช้ืน 
 

 
 

รูปท่ี 24 การต่อวงจรของอุปกรณ์ต่าง ๆ ท่ีใช้วัดค่าคุณสมบัติอากาศช้ืน 
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รูปท่ี 25 กล่องโปรแกรมคุณสมบัติอากาศช้ืน 

3.6 วิธีกำรใช้งำนโปรแกรมคุณสมบัติอำกำศชื้น 

ส าหรับวิธีการใช้งานโปรแกรมคุณสมบัติอากาศช้ืนท่ีได้ท าการสร้างดังท่ีได้กล่าวถึงรายละเอียดไว้แล้งข้างต้น 
จะมีวิธีการใช้งานดังนี้ 

1) ท าการต่อแหล่งจ่ายไฟกระแสตรงขนาด 5 V ให้กับกล่องโปรแกรมวัดค่าคุณสมบัติอากาศช้ืน 
2) เมื่อกล่องโปรแกรมเริ่มท างาน จะสังเกตให้ไฟและตัวอักษรขึ้นบริเวณหน้าจอแอลซีดี ดังแสคงในรูปท่ี 26

ถึงรูปท่ี 29 ซึ่งจะแสดงผลค่าความช้ืนสัมพัทธ์ (Relative Humidity, %) อุณหภูมิกระเปาะแห้ง (Dry-bulb 
Temp, C) ความดันบรรยากาศ (Barometric Pressure, kPa) อุณหภูมิจุดน้ าค้าง (Dew point Temp, C) 
อุณหภูมิกระเปาะเปียก (Wet-bulb Temp, C) อัตราส่วนความช้ืน (Humidity Ratio) ปริมาตรจ าเพาะ (Specific 
Volume, m3/kg) และค่าเอนทัลปี (Enthalpy, kJ/kg) ตามล าดับ 
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รูปท่ี 26 ส่วนหน้าจอแสดงผล (1) 
 

 
 

รูปท่ี 27 ส่วนหน้าจอแสดงผล (2) 
 

 
 

รูปท่ี 28 ส่วนหน้าจอแสดงผล (3) 
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รูปท่ี 29 ส่วนหน้าจอแสดงผล (4) 
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เอกสำรอ้ำงอิง 

[1] นัฐพร ไชยญาติ. (2560). การน าความร้อนท้ิงกลับคืน (พิมพ์ครั้งท่ี 6). เชียงใหม่: ส านักพิมพ์มหาวิทยาลัยแม่
โจ้. 
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ภำคผนวก 

ภำคผนวก ก. รำยละเอียดวัสดุอุปกรณ์ที่ใช้ในโปรแกรมคุณสมบัติอำกำศชื้น 

1) บอร์ดไมโครคอนโทรลเลอร์ Arduino Mega 2560 
Arduino Mega 2560 เป็นบอร์ดรุ่นใหญ่ในตระกูลของบอร์ดไมโครคอนโทรลเลอร์ Arduino ซึ่งมีคุณสมบัติ 

เพิ่มข้ึนจากบอร์ด Arduino Uno R3 จะใช้ชิพรุ่น ATmega2560 ท่ีมีหน่วยความจ าแฟลช 256 KB แรม 8 KB ใช้
ไฟเล้ียง 7-12 V แรงดันของระบบอยู่ท่ี 5 V มี Digital Input/Output มากถึง 54 ขา (เป็น PWM ได้ 14 ขา) มี 
Analog Input 16 ขา Serial UART 4 ชุด I2C 1 ชุด SPI 1 ชุด ซึ่งจะเขียนโปรแกรมบนโปรแกรม Arduino IDE 
และโปรแกรมผ่าน USB เหมาะส าหรับผู้ท่ีสนใจเริ่มต้นท่ีจะเรียนรู้การพัฒนาไมโครคอนโทรลเลอร์ท่ีต้องการบอร์ด 
Arduino ท่ีมีหน่วยความจ าและขาสัญญาณต่าง ๆ ท่ีเพียงพอต่อใช้งานมากขึ้น ท้ังนี้จะมีรายละเอียดเพิ่มเติมดัง
แสดงในตารางท่ี ก.1 และมีแผนผังขาสัญญาณดังแสดงในรูปท่ี ก.1 

 

ตารางท่ี ก.1 รายละเอียด Arduino MEGA 2560 R3 [www.arduinoall.com] 
Microcontroller ATmega2560 

Operating Voltage 5 V 
Input Voltage (Recommended) 7-12 V 
Input Voltage (Limits) 6-20 V 
Digital I/O Pins 54 (of which 14 provide PWM output , 4 UART TTL) 
Analog Input Pins 16 
DC Current per I/O Pin 40 mA 
DC Current for 3.3 V Pin 50 mA 
Flash Memory 256 KB of which 8 KB used by bootloader 
SRAM 8 KB 
EEPROM 4 KB  
Clock Speed 16 MHz 
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รูปท่ี ก.1 แผนผังขาสัญญาณของบอร์ด Arduino Mega 2560 
 

2) เซ็นเซอร์วัดอุณหภูมิกระเปาะแห้งและความช้ืนสัมพัทธ์ DHT22/AM2305 
โมดูล DHT22  หรือ AM2302 มีราคาถูก ให้ค่าเป็นแบบดิจิทัล และใช้ขาสัญญาณดิจิทัลเพียงเส้นเดียวในการ

เช่ือมต่อแบบบิตอนุกรมสองทิศทาง (Serial Data, Bi-Directional) โดยน ามาเช่ือมต่อกับบอร์ด Arduino เพื่อ
อ่านค่าจากเซ็นเซอร์ ซึ่งจะมีข้อมูลเชิงเทคนิค (Technical details) ดังต่อไปนี้ 

- ใช้แรงดันไฟเล้ียงได้ในช่วง: 3.3-5.5 VDC ดังนั้นจึงใช้ได้กับ 3.3 V และ 5 V ได้ 
- วัดอุณหภูมิได้ในช่วง: -40 ถึง 80 °C (ความแม่นย า ±0.5 °C) 
- วัดความช้ืนสัมพัทธ์ได้ในช่วง: 0 ถึง 100% (ความแม่นย า 2-5%) 
- อัตราการวัดสูงสุด: 0.5 Hz 
- ขาเช่ือมสัญญาณเป็นแบบ 4 ขา ( 0.1 inch/2.54 mm spacing) โดย Pin 1 = VCC, Pin 2 = SDA 

(Serial data, bidirectional), Pin 3 = N.C. (Not Connect) และ Pin 4 = GND 
จากข้อมูลเชิงเทคนิคดังท่ีได้กล่าวไปข้างต้น โมดูล DHT22 จะมีผังการต่อขาสัญญาณดังแสดงในรูปท่ี ก.2 
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รูปท่ี ก.2 ต าแหน่งและรายละเอียดการต่อขาสัญญาณของ DHT22 [http://www.myarduino.net] 
 

3) จอแอลซีดีท่ีมีการเช่ือมต่อแบบ I2C  
จอ LCD ท่ีมีการเช่ือมต่อแบบ I2C หรือเรียกอีกอย่างว่าการเช่ือมต่อแบบ Serial จะเป็นจอ LCD ธรรมดา

ท่ัวไปท่ีมาพร้อมกับบอร์ด I2C Bus โดยตรงหรือสามารถเช่ือมต่อภายหลังได้ ซึ่งเหตุผลท่ีท าการเช่ือมต่อกับ I2C ก็
เพื่อต้องการใช้งานท่ีสะดวกยิ่งขึ้น (ลดจ านวนขาสัญญาณในการต่อกับบอร์ดไมโครคอนโทรลเลอร์ลง ) และยังมา
พร้อมกับ VR ส าหรับปรับความเข้มของจอ ในรูปแบบ I2C ซึ่ งจะใช้ขาในการเช่ือมต่อกับบอร์ด
ไมโครคอนโทรลเลอร์เหลือเพียง 4 ขา (ซึ่งจอแอลซีดีท่ีไม่มีการต่อกับ I2C จะเป็นการต่อสัญญาณแบบ Parallel ซึ่ง
จะใช้ 16 ขาในการต่อ) ท้ังนี้ลักษณะการต่อสายสัญญาณจาก I2C ไปยังบอร์ด จะมีลักษณะดังแสดงในรูปท่ี ก.3 

 

 
 

รูปท่ี ก.3 ขาท่ีในการเช่ือมต่อของ I2C ไปยังบอร์ด Arduino [http://www.thaieasyelec.com] 




